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AKVIS ARTSUITE 19.5 | FRAMES AND EFFECTS FOR YOUR PHOTOS

AKVIS ArtSuite is an impressive collection of versatile effects and frames for decorating photos. Make your pictures stand
out!

Decorate a photo to give it an original and festive look!

You may need it on many occasions: when creating a postcard for your friends, making a holiday album, a personalized
desktop wallpaper, or just playing with your images "for art's sake".

AKVIS ArtSuite offers several basic effects that allow creating an endless number of effect versions.

The effects in ArtSuite are grouped as Frames and Effects.

‣  ArtSuite Frames:

The frames in ArtSuite are striking edge effects for photographs. Add elegance and style to an image by putting it into a
classic frame with wood carving or create a funny picture by adding some cheerful frogs, shining stars, and any other
patterns!

The frame samples that come with ArtSuite can be easily tailored to your particular photo. Select a color for the frame;
choose its form, its style, brightness, and the intensity of the applied edge effect. Frames can be easily combined with others
ArtSuite effects.
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You can add a passe-partout, create a frame with ragged or scratched edges, simulate a page curl, give your image a retro
look by adding a vignette.

Create your unique frames! You can load any image as a sample and generate an original photo frame. The result can be
astounding!
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With ArtSuite Standalone, it's not only possible to create frames from samples, but also to apply ready-to-use Hand Painted
Frames, high-quality images with holes of any shape, in which to place photos. Some such frames are included in ArtSuite,
and an additional free set of frames is available for download without charge.
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Also, we offer extra themed frame packs of hand-made frames created by professional artists specifically for use in ArtSuite:
Wedding Pack and Baby Pack, Christmas Pack, each season's collection, Saint Valentine Pack, Halloween Pack, Communion &
Confirmation, and others.

‣  ArtSuite Effects:

The effects in ArtSuite allow experimenting with photos – convert a photo into a B&W image and consequently add a color
shade to it (for example, a sepia effect); replace colors on an image; add a texture (chosen from the built-in Library or
custom one) so that the image looks like drawn on a canvas, brick wall, corrugated paper, etc. Give an artistic touch to your
photos!

You can turn a photo into a halftone picture giving it a retro comic book look, add a touch of glamour to your portrait, apply
brilliant color stripes or the trendy glitch art technique.

Make your photos look fresh and fancy!
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The software includes a set of ready-to-use AKVIS Presets and lets you save your favorite settings (with a texture pattern)
as a preset (into a file .arts).

AKVIS ArtSuite is easy to use and to learn and has a simple and intuitive interface. The program's window displays Before
and After images for comparison. You can switch between them with a click on the image. The Hints panel shows the
description of the parameters and buttons when you hover over them with the cursor.

The Batch Processing feature allows you to apply the same changes to a series of images, thus reducing time and
increasing productivity.

AKVIS ArtSuite is available in two versions – as a standalone program and as plugin to a photo editor. The plug-in version is
compatible with AliveColors, Adobe Photoshop, Photoshop Elements, Corel PaintShop Pro, etc. Check the compatibility of the
plugin.
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INSTALLATION

Follow the instructions to install AKVIS ArtSuite on a computer with Windows OS:

Start the setup exe file.
Select your language and press the Install button.
To continue the installation process you have to read and accept the End User License Agreement.

Activate the check box "I accept the terms in the License Agreement", and press Next.

To install the Plugin, select your photo editor(s) from the list.

To install the Standalone version, make sure that the corresponding option is activated. 
To create a shortcut for the program on desktop, activate Desktop Shortcut.

Press Next.

Press the Install button.
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The installation is in progress.

The installation is completed.

You can subscribe to the AKVIS Newsletter to be informed about updates, events, and special offers. Enter your e-
mail address and confirm that you accept the Privacy Policy.
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Press Finish.

After installation of the standalone version, you will see the program name in the Start menu and a shortcut on the
desktop, if during installation the corresponding option was enabled.

After installation of the plugin, you will see a new item in the Filter/Effects menu of your photo editor. For example in
Photoshop: Filter -> AKVIS –> ArtSuite.
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INSTALLATION

Follow the instructions to install AKVIS ArtSuite on a Mac computer:

Open the dmg file:

- akvis-artsuite-app.dmg to install the Standalone version

- akvis-artsuite-plugin.dmg to install the Plugin into your image editor.

Read the License Agreement and press Agree, if you agree with the conditions.

Finder will open with AKVIS ArtSuite application or AKVIS ArtSuite PlugIn inside.

 

To install the Standalone version, drag the AKVIS ArtSuite app into the folder Applications (or any other place you
like).

To install the Plugin, drag the entire AKVIS ArtSuite PlugIn folder into the Plug-Ins folder of your graphic editor:

Photoshop CC 2021,  2020,  CC  2019,  CC  2018,  CC  2017,  CC  2015.5: Library/Application
Support/Adobe/Plug-Ins/CC;

Photoshop CC 2015: Applications/Adobe Photoshop CC 2015/Plug-ins;

Photoshop CS6: Applications/Adobe Photoshop CS6/Plug-ins.

After installation of the plugin, you will see a new item in the Filter menu of your photo editor (in Photoshop: Filter ->
AKVIS -> ArtSuite).
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Run the standalone program by double-clicking on its icon in Finder.

You can also run the AKVIS program from the Photos app by choosing the Image -> Edit With command (in High Sierra and
later versions of macOS).
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HOW TO ACTIVATE AKVIS SOFTWARE

Attention! During the activation process your computer must be connected to Internet.

If it is not possible, we offer you an alternative way (see below for Offline Activation).

 

Download AKVIS ArtSuite and install the program. Read the Installation Instruction here.

When you run the unregistered version, a splash window will appear displaying general information about the version and the
number of days left in your trial period.

You can also open the About the Program window by pressing the button  in the program's Control Panel.

 

Click on TRY IT to evaluate the software. A new window will appear with variants of licenses to test.

You do not need to register the trial version to try all features of the software. Just use the program during the evaluation
time (10 days after the 1st start).

During the test period you can try all options and choose the license you like. Select one of the offered functionality types:
Home (Plugin or Standalone), Home Deluxe, or Business. Your choice of license will affect which features will be available
in the program. Consult the comparison table for more details about license types and versions of the software.

If the trial period has expired, the TRY IT button is disabled.

 

Click on BUY NOW to choose a license to order.

When the payment is effected, your serial number for the program will be sent to you within minutes.

 

Click on ACTIVATE to start the activation process.
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Enter your name (the program will be registered to this name).

Enter your serial number (your license key).

Choose the method of activation — either direct connection to the activation server or by e-mail.

Direct connection:

We recommend activating the program using direct connection, as it is the easiest way.

At this step your computer must be connected to Internet.

Press ACTIVATE.

Your registration is completed!

Request by e-mail:

In case you have chosen activation by e-mail, a message with all necessary information will be created by the program.

NOTE: You can also use this method for Offline Activation:

If your computer is not connected to Internet, transfer the activation message to a computer connected to Internet,
for example, with a USB stick. Send us this information to: activate@akvis.com.

Please do not send the screenshot! Just copy the text and save it.

We need your serial number for the software, your name, and HardwareID (HWID) of your computer.

We will generate your license file (ArtSuite.lic) using this information and will send it to your e-mail address.

Save the .lic file (do not open it!) to your computer where you want to register the software, in the AKVIS folder in
Users’ Shared (Public) Documents:

Windows 7/8/10:

Users\Public\Documents\AKVIS;

Mac:

Users/Shared/AKVIS.

Your registration is completed!
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When the program is registered, BUY NOW turns to UPGRADE that lets you improve your license (for example, change
Home to Home Deluxe or Business).
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WORKSPACE

AKVIS ArtSuite can work independently as a standalone program as well as a plug-in to a photo editor.

Standalone is an independent program; you can open it by clicking on the program’s icon.

To launch the standalone version, run the program directly:

On a Windows computer - select it from the Start menu or use the program’s shortcut.

On a Mac computer - launch the app from the Applications folder.

Plugin is an add-on for a photo editor, for example for Photoshop.

To call the plugin, select it from filters of your image editing program.

 

The workspace of AKVIS ArtSuite looks like this:

Features of the Workspace:

Most of the AKVIS ArtSuite workspace is taken by the Image Window with two tabs: Before and After. The Before tab
shows the original image, the After tab shows the result. To switch between the tabs and compare the original and the
resulting images, just left-click on any point of the image.

In the upper part of the window you can see the Control Panel. The Control Panel has the following controls:

The button  opens the home page of AKVIS ArtSuite.

The button  (only in the standalone version) opens an image for processing. The hot-keys are Ctrl+O  on

Windows, ⌘ +O  on Mac. Right mouse click on this button displays the list of recent files. You can change the number

of recent documents in the program's Preferences.
The button  (only in the standalone version) saves the processed image to the disk. The hot-keys are Ctrl+S  on

Windows, ⌘ +S  on Mac.

The button  (only in the standalone version) prints the image. The hot-keys are Ctrl+P  on Windows, ⌘ +P  on

Mac.
The button  lets posting pictures from the program to the social networks.

The button  exports user presets to a file *.arts.

The button  imports the saved user presets (*.arts).

The button  /  turns the selection on/off (only for the Glitch Art effect).
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The button  (only in the standalone version) opens the Batch Processing dialog to automatically process a series

of images.
The button  starts applying the chosen frame/effect to the image. Use hot-keys: Ctrl+R  on Windows, ⌘ +R  on

Mac.
The button  (only in the plug-in version) applies the result and closes the program window of AKVIS ArtSuite. The

hot-keys are Ctrl+S  on Windows, ⌘ +S  on Mac.

The button  calls information about the program.

The button  calls help files to the program. The hot-key is F1 .

The button  calls the Preferences dialog box.

The button  opens a window showing the latest news about ArtSuite.

Moving and scaling the image is done in the Navigator. In the Navigator you can see the reduced copy of the image. A
frame surrounds the part of the image visible in the Image Window; the area outside of the frame will be shaded. The frame
can be dragged to display a different part of the image. To move the frame, bring the cursor inside the frame, press the left
mouse button and while keeping it pressed, drag the cursor.

Additionally, you can move the image in the Image Window with the scroll bars or by holding down the space bar, then
holding down the left mouse button while moving the mouse. The mouse's scroll wheel can move the image up and down, and
holding Ctrl  on Windows, ⌘  on Mac – while using the scroll wheel will move the image left and right. Holding  Alt  on

Windows, Option on Mac will scale the image. Right-click on the scroll bar to activate the quick navigation menu.

It is also possible to enter a new scale coefficient into the appropriate field. Frequently used scale coefficients can be found
in a fall-down menu. You can also scale the image using hot-keys: +  and Ctrl++  on Windows, ⌘ ++  on Mac to scale up

the image, -  and Ctrl+-  on Windows, ⌘ +-  on Mac to scale down the image.

Under the Navigator there is the Settings Panel where you can select a Frame/Effect, choose a Preset, and adjust the
parameters.

Under the Settings Panel you can see Hints for the parameters and buttons when you hover over them with the cursor. You
can choose where the hints will be shown or hide them in the Preferences.
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HOW IT WORKS

AKVIS ArtSuite can work independently as a standalone program as well as a plugin to a photo editor.

Follow the instructions below to add a frame/effect to an image with AKVIS ArtSuite:

Step 1. Open an image.

- If you work with the standalone edition:

The dialog box Select File to Open appears if you double-click on the empty workspace of the program or if you
click on the button  on the Control Panel. You can also drag the image into the program workspace.

The Standalone edition of AKVIS ArtSuite supports BMP, JPEG, PNG, TIFF, and RAW file formats.

- If you work with the plugin:

Open an image in your photo editor by calling the command File -> Open or using the key combination Ctrl+O .

Call the AKVIS ArtSuite plugin. To this effect, select the menu item:

In AliveColors: Effects -> AKVIS -> ArtSuite;
in Adobe Photoshop: Filter -> AKVIS -> ArtSuite;
in Corel PaintShop Pro: Effects -> Plugins -> AKVIS -> ArtSuite;
in Corel Photo-Paint: Effects -> AKVIS -> ArtSuite.

Attention! Some frames in ArtSuite have Transparency. We recommend you start working with the plugin by
unlocking the background layer or making the layer's copy. Otherwise, the result achieved with ArtSuite will not
be visible.

Step 2. Select Effects or Frames, then choose one of the frames/effects available in the drop-down menu. You can
apply one of the AKVIS Presets or adjust the settings to your liking.
Step 3. Choose the processing mode. By default, the Autorun Mode is enabled, and the image is processed
automatically. You can disable the Autorun Mode check-box in the Preferences  and start image processing

manually by pressing .

The result will be shown in the After tab. By clicking anywhere in the image, you can temporarily switch between the
Before and After tabs.
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Step 4. You can add text, watermark, or logo to your image in the Text tab. Enable one of the options: either Text or
Image.
Step 5. It is possible to save the settings as a preset for further use.

To save a preset, enter its name into the Presets field above the settings and press Save.

If you change the parameters, you can always come back to the default settings of the selected preset by pressing
Reset.

To delete your preset, select it from the list and press Delete.

The icon /  next to the Presets field adds the selected preset to Favorites or removes it from this group of

presets.

To export user presets as a separate file with the ending .arts use . To load previously saved presets, press .

Step 6. You can share your image by clicking on .

In the standalone version you can also print your picture with .
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Step 7. Save the processed image.

- If you work with the standalone edition:

Click on the button  to open the Save as dialog box. Enter a name for the file, choose the format (TIFF,

BMP, JPEG, or PNG) and indicate the target folder.

- If you work with the plugin:

Press the button  to apply the changes and to close the plug-in window.

Call the Save As dialog box using the command File -> Save As, enter a name for the file, choose the format
and indicate the target folder.
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ADD TEXT OR WATERMARK

In AKVIS ArtSuite, you can personalize your picture by adding a signature, a greeting inscription, a clip art image, or any
design elements, insert a logo or a watermark.

Switch to the Text tab and enable one of the modes: Text or Image.

 
Adding Text

Learn more about the settings of the Text tab.
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PROGRAM PREFERENCES

The button  opens the Preferences dialog box. It looks like this:

Language. Change the program language by selecting another from the drop-down list.
Interface Scale. Choose the size of the interface elements. When it is set to Auto, the program workspace will
automatically scale to fit the screen resolution.
Interface Theme. Select the style of the program interface: Light or Dark.
 Autorun Mode check box. If this box is checked, any changes to the frame will be updated automatically. We do not
recommend using this mode with the Texture effect or the Frost frame.

This mode does not work when using a Hand Painted frame. You must press the  button in order to see changes

applied.

Recent Files (only in the standalone version). The number of recent documents. The list of the recent files, sorted by
time, become visible by right mouse clicking on . Maximum: 30 files.

Lock the Control Panel check-box. It disables the possibility to hide/show the top panel. If the check-box is selected
the panel is always visible. Uncheck the option to unlock the panel, and you will be able to hide/show it by clicking on
the small triangle button (in the middle of the panel). The minimized panel will be shown when moving the cursor over it.
Set Frame Packs Folder (only in the standalone version). Select a folder where you want to keep additional frame
packs (*.zip files) to use them in the Library of Hand Painted Frames.

By default, this is the AKVIS folder in the Shared Documents folder, but you can choose any folder you wish.

Hints. Choose how the hints will be shown:

- Under Image Window;
- Under Settings Panel;
- Hide.

To save changes made in the Preferences window press OK.

If you need, click on the button Default to come back the default settings.
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BATCH PROCESSING

AKVIS ArtSuite supports the Batch Processing feature that lets you automatically convert a series of images with the
same effect settings and saves you time and efforts. It is useful when creating a number of illustrations at the same style for
a booklet or when processing all frames of video.

 

If you use the standalone version of AKVIS ArtSuite, read the instructions here.

If you use the ArtSuite plugin in Photoshop, use this tutorial.
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BATCH PROCESSING WITH PHOTOSHOP PLUGIN

The AKVIS plugins support the automation feature in Adobe Photoshop.

Batch processing is very useful and time saving when you have to apply the effects to a number of photos. This method
applies the same settings to a folder full of images.

Even if you have never used batch processing you will find no difficulties in understanding it. First you create an Action in
Photoshop and then apply it to a photo folder.

Follow the instructions:

Step 1. Create two new folders, for example: "source-files" and "result-files". Place original images into the "source-
files" folder. The results will be saved in the "result-files" folder.
Step 2. Open one of the original images in Adobe Photoshop. We will use this photo to adjust the plugin's settings and
create an action.

Step 3. In the Actions palette click Create New Set button. In the dialog window give a name for a new set of
actions, for example, "AKVIS Actions".

If you already have a special set for the AKVIS actions, you can just choose it.

Actions Palette

Step 4. Press Create New Action and give a name for it, for example, "Neon".
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New Action

Press the Record button, and the recording of the action will immediately start.

Step 5. Call the plugin and adjust its parameters.
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Step 6. Press the button . The plug-in window will close and the effect will be applied to the image. In the Actions

palette, in your new action, you will see a new line with the plugin's name.

Step 7. Remember that the action is still being recorded. Now, you should save the image. Choose Save As in the File
menu and save the image into the destination folder.
Step 8. Stop the action recording by pressing Stop playing/recording at the bottom of the Actions palette.

Step 9. Delete the file that you have just saved.
Step 10. The action is created and you can proceed to batch processing of the photos.

In the File menu of the editor choose Automate -> Batch.

Step 11. In the Batch dialog window and set the parameters:
In the Set drop-down list choose "AKVIS Actions" and the new action.
In the Source option set Folder. Press the Choose… button and select "source-files".
As the Open command was not recorded in the action, the Override Action "Open" Commands check-box
should be deactivated.
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For Destination select Folder, then press the Choose… button and select "result-files".
Activate Override Action "Save as" Commands check-box.
In the File Naming section you can create the filenames structure for the resulted images. If you do not want to
change the names, in the first combo-box choose document name, and in the second - extension.

Step 12. Press OK to start processing. Photoshop will apply the AKVIS plugin to all photos in the "source-files" folder,
one by one, and will save them to the "result-files" folder.
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PRINT IMAGES IN AKVIS ARTSUITE

In the standalone version of AKVIS ArtSuite you can print the image. Press the button  to open the Print options.

Print Options in AKVIS ArtSuite

Adjust the parameters appearing in the Settings Panel:

Choose a printer from the list of available devices, set the desired resolution, as well as the number of copies to print.

In the Orientation group, set the position of paper: Portrait (vertically) or Landscape (horizontally).

Click the Page Setup button to open a dialog box to choose the size of the paper and its orientation, as well as the
print margins.

Press the Reset Margins button to return the page margins to the default size.

Change the size of the printed image adjusting the parameters Scale, Width, Height and Fit to Page. These
parameters have no effect on the image itself, just on the print version. You can change the size of the printed image
by entering any value in %, or by entering new values in Width and Height.

To adjust the size of the image to the paper size, select Fit to Page.

Move the image on the page with the mouse or align it using the arrow buttons.

You can activate Frame for the image and adjust its width and color.

Choose the Background Color by clicking on the color plate.

In the Page tab, you can adjust printing of the multiple copies of the image on a single sheet.
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Print Page

Copies per Page. It lets you specify the number of copies of the image on one page.
Horizontally and Vertically. These parameters indicate the number of rows and columns for the copies of the
image on the page.
Spacing. The parameter sets the margins between the copies of the image.

In the Poster tab, it's possible to customize printing of the image on multiple pages for the subsequent junction into a
large picture.

Print Poster

Pages. If the check-box is enabled, you can specify the maximum number of the pages in which the image will be
divided. The image scale will be adjusted to fit this number of the sheets. If the check-box is disabled, the
program will automatically select the optimal number of the pages in accordance with the actual size of the image
(scale = 100%).
Glue Margins. If the check-box is enabled, you can adjust the width of the padding for bonding sheets. Margins
will be added to the right and to the bottom of each part.
Show Numbers. With the enabled check-box, a sequence number of each part, by a column and a row, will be
printed in the margins.
Lines of Cut. Activate the check-box to display the cut marks in the margins.

AKVIS ArtSuite

29



To print the image with the chosen parameters, press the Print button. 
To cancel and close the printing options click on Cancel.

Click the Properties... button to open a system dialog box that enables you to access the advanced settings and send the
document to print.

 

AKVIS ArtSuite

30



 
Color Photo

 
B&W Effect + Toning

BLACK AND WHITE

The Black & White effect in AKVIS ArtSuite converts a color photo to a black and white image and adds a color tint to it
(for example, a sepia tone).

B&W conversion:

Color to Gray Mixer. The hexagon consists of 6 sections, each having one color and a control. Use the control to
darken or lighten the gray tones that correspond to the original image colors and are close to the section color. The
closer the control to the center, the darker the tone, and vice versa, the farther from the center, the lighter the tone.

The default settings can be restored with a left-click on the gray hexagon in the center.

 

B&W Conversion, Default parameters

 

Adjusting the B&W Conversion

Toning:

Tint. Choose a color on the gradient circle to add a color tint to the image. By default, the control is in the center of
the gradient circle and the image has gray tones. You can set a tint with a left-click on the gradient circle; the control
will move to the defined point. The control also regulates the tint saturation - the farther from the center, the more
saturated the color shade is.
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Adding a Color Tone to an Image

 

Increasing Saturation

Coloration (0-100). This parameter mixes the resulting grayscale image with the original one. The values of the
parameter vary between 0 and 100. By default the value is set to 0, which means that there is no mixing. As you
increase the value, the original image becomes more visible through the grayscale image, adding original colors to it.
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Original Image

 

Color Shift for Blue

SHIFT COLORS

The Shift Colors effect shifts colors on an image with consequent saturation and lightness adjustment.

Below is an example of the effect application. The blue color was replaced by red, other colors stayed the same.

 

The effect has the following controls that are represented by gradient lines:

The middle gradient line defines the effect application area.

The effect application area (the color/colors that will be shifted) is defined by a gradient line with 4 sliders under it:
two outer and two inner sliders.

The colors between the inner sliders will be affected to the full extent. The colors between the inner and the outer
sliders will change less (the farther from the inner slider, the weaker is the effect influence). The colors outside the
outer sliders will stay the same.

Default Settings

Move the sliders to change the effect application area. For this purpose, bring the cursor to one of the sliders, left-
click on it, and drag it to the required position on the line.

 

Moving The Inner Slider

 

Moving The Outer Slider

To move all 4 sliders at once, bring the cursor in the middle of the inner sliders, left-click on it, and, keeping the left
mouse button pressed, move the sliders to the required position.

 

Moving All Sliders at Once

The upper gradient line regulates the color shift. Bring the cursor to the gradient line, left-click on it, and, keeping
the left mouse button pressed, move the slider to the left/right, in such a way, that the required colors are above the
effect application area.

 

Moving The Upper Gradient Line

The lower gradient line shows the result of the color shift.

Compare the middle and the lower gradient lines to see which color and how it will be changed.

All Colors. When the check-box is enabled, all image colors are affected by the change. In this case only two gradient lines
are displayed: the lower one shows the original color range, while the upper gradient line adjusts the color shift.

Apply to All Colors
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The Saturation (-50..50) parameter changes the intensity of the image colors. The values of the parameter vary between
-50 (grayscale) to 50 (bright colors). By default the parameter is set to 0.

The Lightness (-50..50) parameter changes the overall lightness of the image, making it darker or lighter.
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Original Image

 

Channel Mixer

 

Increasing Red in Every Point

 

Reducing Red in Every Point

 

Increasing Red in Red Channel

 

Reducing Red in Red Channel

CHANNEL MIXER

The Channel Mixer effect processes the image (changing its color tones, saturation, contrast, lightness, etc.) using three
channels: Red, Green and Blue.

 

Every channel is represented by a scale with a triangle control.

The parameter can be adjusted in the following way:

Shifting the triangle to the right/left leads to increase/reduction of the corresponding color component in every
image point.

Enlarge/reduce. Left-click on a triangle's corner and move the cursor to or from the center of the triangle. By
increasing or reducing the triangle size, you strengthen or weaken this color component. The color is strengthened or
weakened only in the points where it was, other points of the image stay unchanged.

Change the color of the triangle. For this purpose, left-click on the white circle at the apex of the triangle, and drag
it to another apex. For example, if we change the triangle's color in the red channel to blue, the red color components
in every point of the channel will become blue.
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Original Image

 

Replacing a Color in a Channel

 

Original Image

 

Replacing a Color with Two Colors in a Channel

 

Original Image

 

Replacing a Color with Three Colors in a Channel

Change the color of the triangle to two color sectors. For this purpose, left-click on the white circle at the apex of
the triangle, and drag it to one of the triangle' sides. For example, if the triangle in the green channel consists of blue
and red sectors, the new value of the green color component will be calculated as a sum of blue and red components.
Other color components will not change.

Change the color of the triangle to three color sectors. For this purpose, left-click on the white circle at the apex of
the triangle, and drag it towards the middle of the triangle. For example, if the triangle in the blue channel consists of
three color sections, the new value of the blue component for every point of the image will be calculated as a sum of
these three color sections. Other color components on the image (in this case, red and green) will not change.

Attention! The triangle control does not show the result. It only shows the way the points in this channel will be calculated.
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Original Image

 

Texture effect

TEXTURE

The Texture effect imitates a drawing on an uneven surface, such as corrugated paper, brick wall, metallic or ceramic
coating, etc.

The process can be divided into two stages:

1. Adjustment of texture properties.
2. Adjustment of texture application parameters.

It is possible to adjust the following texture properties:

Texture. The program comes with a rich collection of textures. The most suitable patterns for this effect can be
found in the Surface group of the Library.

The selected (current) texture is displayed in a square button which also lets opening the Library.

Click on the square, you will see all textures in the selected group. Now you can select a texture by clicking on it.

Hint: It is possible to apply your own textures. It can be any image in these formats: JPEG, BMP, TIFF, or PNG.

To load your own texture, select <Custom>... in the list of the Library.

Scale (10-400). The parameter sets the size of the repetitive pattern. By default the Scale is set to 100%. The higher
the value of the parameter, the larger the pattern is.
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Scale = 20%

 

Scale = 200%

These are the following options that define the way the texture is generated:

Repetition. When this option is selected, the texture is generated by simple repetition of the given pattern.

Repetition

Reflection. When this option is selected, the texture is generated by repetition of the given pattern. The
difference from the Repetition mode is that the ends of the patterns are joined at mirror reflection.

Reflection

Alignment. This option helps when the initial texture has an uneven pattern. If we apply the texture as it is, we
will see texture joins. To avoid it, we should activate the option Texture Alignment.
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Alignment Other option

 

Brightness = 10

 

Brightness = 90

 

Embossing = 30

 

Embossing = 150

It is possible to adjust the following texture appication parameters:

Light Source. Use the dagger on the ball to set the probable light source during the shooting. The position of the light
source influences the texture wrapping. To change the position of the light source, left-click on the required point of
the ball.

Brightness (0-150). This parameter changes the texture brightness. The brightness of the original texture is 90. The
higher the value of the parameter, the lighter the texture is. As a result, the output image gets lighter.

Embossing (0-150). This parameter allows a texture to be embossed. At 0, the texture is flat. As you increase the
value of the parameter, the texture gets more prominent.

Reveal Texture (0-40). The parameter defines to what extent the texture is shown through the image. The higher the
value, the more distinct the texture is and the less visible the original image is. A higher value of the parameter also
increases the influence of the Brightness parameter and the texture contrast.
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Reveal Texture = 10

 

Reveal Texture = 35

 

Distortion = 5

 

Distortion = 50

Distortion (0-50). This parameter defines the clearness of the resulting image. The higher the value of the parameter,
the more distorted and blurred the images is.

Hint: Most of the processing time is taken by the first stage (texture generation). Therefore, it is recommended to adjust the
texture's properties at first. Then you can try different settings for texture application parameters.
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GLAMOUR EFFECT

Glamour is everything luxurious, stylish, and fashionable. If you call a woman a glamour girl, you pay her a special
compliment, showing attention to her beauty, charm, or sexual magnetism.

Glamour also means a special style in photography, which pays close attention to the appearance of the model. The skin
must be smooth and pure. The glamour effect conceals skin defects, reduces small wrinkles and makes the model look
perfect.

Every woman wants to feel charming and attractive, especially on the photos that are kept in the photo albums for years.

The Glamour effect, that processes skin and masks defects, has been developed specially for women. Now you can add the
note of glamour to your image. Not only movie stars can be glamorous!

 
Original image
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Result

The effect has the following controls:

Colors. This field includes a set of colors that will be used for processing an image.

 

Set of the colors

This set has 6 color squares. By default these color squares are empty. If you start image processing with default
settings, there will be no changes.

Click on an empty square, the pointer will be transformed into an eyedropper, and pick a color from the image with a
left-click. This square will display the chosen color.

To change the color of the square, left-click on it and choose another color from your image.

To delete a color and clear the square, right-click on the square. The square will return to the default state.

Note: The button Reset to Default Settings allows recovering the default settings of the parameters.

The Threshold (0-20) parameter defines colors that will be used for processing. At minimum value of the parameter
only the colors from the color set are involved into the process. If you increase the value of the parameter the colors
similar to the colors of the set will change, too. The higher the value of the parameter, the more colors will be changed.
The Smoothness (1-100) parameter softens and blurs the image by reducing the color contrast between the
neighbouring pixels.
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Smoothness = 10

 

Smoothness = 75
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Original Image: 

Black key color (0,0,0),
White key color (255,255,255)

 
Result: 

Black key color (49,10,98),
White key color (242,255,172)

TWO KEYS

The Two Keys effect allows you to transform an image (change color tints, replace colors, adjust contrast and brightness,
etc) using two key colors.

The effect has the following controls that are represented by two color boxes:

 
Original key colors

The color that will serve as the black key color is set in the upper color box; the white key color is defined in the lower box.
By default the corresponding colors are chosen, and your image is in its original state.

How to define another key colors:

- Click on the color box (the pointer will transform into an eyedropper), choose the necessary color on the image and
left-click it. The color box will change its color to the selected one.

- Double-click on the color box to open the Select Color dialog.

 
Set new key colors

As a result, all colors that are darker than the black key will shift to the black color; all colors that are lighter than the white
key will shift to the white color.

You can also set only one key color (black key or white key). If you define only the black key, the dark colors will shift to the
black color, while the light colors will not change.

Please note, that the lighter the black key color is, the darker the image will be; the darker the white key color is, the lighter
your image will be.

Note: If you don't want to change the color shades on your image, use the color grey as the key color (in this case the color
components (green, red and blue) are equal).
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Original Image: 

Black key color (0,0,0),
White key color (255,255,255)

 
Result: 

Black key color (50,50,50),
White key color (220,220,220)
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Original Image Halftone Effect

 

Posterizing = 5

 

Posterizing = 30

HALFTONE EFFECT

The Halftone effect turns a photo into a halftone picture giving it a retro comic book look. The image is represented with
dots in a specific pattern. This technique is widely used for creating outstanding designs and stylish posters and for
screenprinting.

Adjust the effect's parameters:

Posterizing (0-30). The association of similarly colored pixels. At higher values of this parameter, fewer colors are
used, and the image becomes more uniform and flat.

Grid. Choose a layout chart of the elements of the regular grid:

Rectangular - the dots are located directly in the grid nodes, squaring up the image.

Triangular - three adjacent dots create a regular triangle.

Linear - the image is displayed in non-uniform lines.
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Rectangular Grid Triangular Grid Linear Grid

 

Diamond Shaped Pattern

 

Square Shaped Pattern

 

Interval = 12

 

Interval = 25

 

Pattern. Select a shape of the elements: Circle, Square, Diamond, Horizontal Line, Vertical Line.

 

Interval (5-100) is a space between the elements. The less the value of the parameter, the denser the dots are.

 

Size (1-100) changes a maximum size of a dot. It depends on the lightness of the source pixels: the dark dots are
drawn in this size, the light dots are displayed with a smaller diameter. The large elements can merge into painted
areas.
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Size = 7

 

Size = 20

 

Brightness = 20

 

Brightness = 70

 

One Color Halftone

 

Full Color Halftone

 

Brightness (0-100) defines the color intensity and opacity of the dots.

 

One Color. By default, the check-box is deactivated and the image is drawn with the colors of the original photo.
When the check-box is activated, all dots are painted with the chosen color. Click on the plate and choose a color from
the Select Color dialog.

 

AKVIS ArtSuite

48



 
Stripe Count = 3

 
Stripe Count = 15

COLOR STRIPES

Color Stripes effect allows splitting the image into separate areas with different color properties.

Attention! This effect is only available for Home Deluxe and Business licenses.

Color Stripes Effect (Double Application)

Effect Parameters:

Stripe Count (3-50). The parameter defines the number of stripes the image will be divided into.

Rotate (-90..90). The parameter rotates the stripes along the y-axis.
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Rotate = 0 (no rotation)

 
Rotate = 50 (to the right)

 
Curvature = 0 (no curvature)

 
Curvature = -10

Left Center Right

Curvature (-10..10). This parameter regulates the degree of curvature of stripes.

Main Stripe. You can adjust the position of the no-effect area:

Main Stripe Width (1-50). When the check-box is enabled, you can set the size of the no-effect area (as a percentage of
the width of the image). When the check-box is disabled, all stripes have the same width.
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Main Stripe Width = 30%

 
Main Stripe Width = 50%

 
Splitter Width = 0

 
Splitter Width = 10

 
Yellow Lines

 
Ruby Lines

Splitter Width (0-10). The width of dividing lines.

Splitter Color. The color of dividing lines.

 

Using the Left and Right tabs, regulate the parameters of the stripes adjacent to the main stripe.
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Hue = -162

 
Hue = 78

 
Saturation = -100

 
Saturation = 100

 
Brightness = -100

 
Brightness = 100

Hue (-180..180). The parameter shifts all colors by the same hue value.

Saturation (-100..100). The parameter changes the intensity of the image colors (from neutral gray tones to highly
saturated hues).

Brightness (-100..100). The parameter changes the brightness of the image. At higher values, the image points become
lighter. At lower values, the image points become darker.
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Colorize Check-Box Is Disabled

 
Colorize Check-Box Is Enabled

(Pink Color)

Colorize. The check-box allows you to recolor the image using shades of the specified color. Click the color plate to select a
color.

You can use the Random Shape and Random Colors buttons to generate a random effect variation.
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Red Channel Green Channel Blue Channel

GLITCH ART

Glitch Art adds digital noise and distortions to an image, creating the effect of a spoiled picture. In reality, such
interferences appear due to errors in the reproduction of digital recordings, technical failures, or physical damage of a device.
Many contemporary works of art use this visual technique. It is one of the most popular trends in photography and
videography. With ArtSuite, it's easy to apply chaotic and mesmerizing glitches to your pictures.

Attention! This effect is only available for Home Deluxe and Business licenses.

Glitch Art Effect

 

The effect parameters are presented in two tabs: Interferences and Stripes and Shifts.

 

Interferences Tab

Channel Shift. The parameters of this group separate and shift the color components of the image, forming additional color
outlines (the so-called 3D anaglyph effect).

Red. Shift of the red channel.

Green. Shift of the green channel.

Blue. Shift of the blue channel.

Shift in Channels by 10

Scan Lines. Raster lines that simulate an old TV noise effect.

Blend Mode: Overlay or Soft Light. The mode affects the degree of contrast between the lines and the image.
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Overlay

 

Soft Light

 

Thickness = 1

 

Thickness = 10

 

Sharpness = 0

 

Sharpness = 50

 

Intensity = 10

 

Intensity = 80

Thickness. Thickness of the scan lines.

Sharpness. Sharpness of the edges of the lines.

Intensity. The degree of visibility of the lines. At 0, there is no scan line effect.

AKVIS ArtSuite

55



 

Strength = 10

 

Strength = 90

Effect on The Entire Image Excluded Area Stripes Outside The Selection

Noise. Adding digital noise and film grain to the image.

Strength. The degree of visibility of noise.

 

Stripes and Shifts Tab

You can add rectangular straight regions (stripes) to the image and change them dynamically.

The Exclusion Tool  allows you to indicate areas where there will be no stripes, protecting the selected part from the

effect.
Use the Eraser tool  to edit the selection (protective zone).

You can turn the selection preview on/off with  /  in the Control Panel.

Size and Position. A group of the parameters responsible for the geometry of the stripes.

Min/Max Height. Range of change of the height of the stripes.
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Min/Max Height = 1/10

 

Min/Max Height = 70/120

 

Min/Max Length = 20/30

 

Min/Max Length = 190/200

 

Displacement = 0

 

Displacement = 25

 
Simple Shifts = 40

 
Simple Shifts = 80

Min/Max Length. Range of change of the length of the stripes.

Displacement. Shift amount (for simple and inverted stripes).

Simple Shifts. The number of stripes created by displaced rectangles.
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Simple Stretches = 40

 
Simple Stretches = 80

 
Min/Max Stretch = 12/12

 
Min/Max Stretch = 12/20

 
Inverted Shifts = 40

 
Inverted Shifts = 80

Simple Stretches. The number of stripes formed by stretching of rectangles.

Min/Max Stretch. Range of change of the length of the stretches.

Inverted Shifts. The number of stripes with color inversion.

The Vertical check-box enables vertical effects instead of horizontal ones.
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Vertical Check-Box Is Disabled

 
Vertical Check-Box Is Enabled

The Random Seed button generates a different distribution of stripes in the image.

Different Distribution of Stripes
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CLASSIC FRAME

The Classic Frame offers a wide range of frame patterns - from classic wooden frames to festive Christmas decorations,
fabric, brick and even animal world patterns (peacock feather, leopard skin, etc). These patterns are available in both editions
(plugin and standalone) and let you generate various frames. You can also load your own texture to create an unique frame.

The Settings Panel lets choosing a texture to generate a frame and adjust the parameters for the selected frame.

 

Texture. Select a group from the list and a texture (pattern) from the texture Library.

The program comes with a rich collection of textures. Textures for the Classic Frame are found under Classic and are
grouped in several sets. Here you can see a group with classic wooden frames, as well as groups with animal textures
(peacock feather, leopard skin, etc.), bricks, festive elements and so on.

The selected (current) texture is displayed in a square button which also lets opening the Library.

Click on the square, you will see all textures in the selected group (for example, Wooden). Now you can select a texture by
clicking on it.
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Frame Width = 30%

 
Frame Width = 70%

 
Scale Image to Frame
Check-Box Disabled

 
Scale Image to Frame

Check-Box Enabled

Hint: It is possible to apply your own textures. It can be any image in these formats: JPEG, BMP, TIFF, or PNG.

To load your own texture into AKVIS ArtSuite, select <Custom>… in the list.

Adjust the following parameters for this digital picture frame:

Frame Width (0-100%). This parameter sets the width of the frame. At 0% there is no frame, at 100% the width of the
frame makes a quarter of the minimum image size (as to its width or height). For example, for an image 600 x 800 pixels the
100% width of the frame is calculated as follows: 1/4 from the minimum size (600 px) is 150 pixels.

Scale Image to Frame. When the check-box is enabled, the image is scaled to fit the frame. When the check-box is
disabled, the frame overlays the image on it borders.

Attention! A part of the image will be cropped to keep the aspect ratio.

Texture Brightness (0-200%). This parameter changes the brightness of the original texture. The brightness of the original
texture equals 100%. To darken the frame, set the value of the parameter less than 100%; to brighten the frame, set a value
higher than 100%.
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Texture Brightness = 50%

 
Texture Brightness = 130%

 
Flip Texture Vertically Button Disabled

 
Flip Texture Vertically Button Enabled

Flip Texture Vertically . When the button is activated, the texture is oriented to the horizontal line, that is top-down.

As a result the outer and the inner border of the frame swap over.

 

If the original texture is not perfect, the joins are visible and the frame is uneven. To smooth the joints, use the buttons:

Mirror Texture to Align  and Average Brightness . These buttons can be used separately or together.

The Mirror Texture to Align button  joins textures taking into account their brightness - the bright end of the

texture joins the bright end, the dark end joins the dark end. The textures are mirrored in this way to achieve a smooth
transition.

The Average Brightness button  smoothes the visible texture joints by averaging their brightness.

Let's take a texture having uneven brightness - the left part of the texture is brighter than the right.

If you generate a frame using this texture with both buttons (Mirror Texture to Align and Average Brightness) disabled, you
will have the following picture:
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Mirror Texture to Align

Button Enabled

 
Average Brightness and
Mirror Texture to Align

Buttons Enabled

Buttons Disabled Mirror Texture to Align
Button Enabled

Average Brightness
Button Enabled

Let's take one more example to show how the parameters Average Brightness and Mirror Texture to Align work. We take
the following texture:

In this case it is enough to enable the Average Brightness button to achieve a good result.

 

3D Effect

Enable the check-box to give the frame a 3D look.

AKVIS ArtSuite

63



 
Volume = 20

 
Volume = 100

3D Effect 
(Compare OFF/ON check-box.)

Effect parameters:

Light Source. Use the dagger on the ball to set the probable light source that affects the appearance of the shadow.

Volume (0-100). This parameter affects the depth of the picture frame. At 0, the texture is flat.

Smooth Transition (-50..50). The parameter adjusts the smoothness of the border between the convex part and the bevel.
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Smooth Transition = -50

 
Smooth Transition = 50

 
Bevel Width = 35

 
Bevel Width = 75

Bevel Width (0-100). This parameter sets the size of the bevel.
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PATTERN FRAME

The Pattern Frame is formed by regular patterns generated all along the perimeter of the image. As a pattern you can take
a sample from the built-in Texture Library (flowers, butterflies, hearts, cakes, etc) or load your own images on a transparent
background.

The Settings Panel lets choosing a texture to generate a frame and adjust the parameters for the selected frame.

 

Texture. Select a group from the list and a texture (pattern) from the Texture Library.

The program comes with a rich collection of textures. Textures for the Pattern Frame are found under Pattern and are
grouped in several sets.

The selected (current) texture is displayed in a square button which also lets opening the Library.

Click on the square, you will see all textures in the selected group (for example, Nature). Now you can select a pattern by
clicking on it.
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Frame Width = 30%

 
Frame Width = 80%

 
Texture Brightness = 50%

 
Texture Brightness = 200%

Hint: It is possible to apply your own textures. It can be any image in these formats: JPEG, BMP, TIFF, or PNG.

For pattern frames we recommend to use PNG images with an object on a transparent area.

To load your own texture into AKVIS ArtSuite, select <Custom>… in the list.

Adjust the following parameters for this digital picture frame:

Frame Width (0-100%). This parameter sets the width of the frame. At 0% there is no frame, at 100% the width of the
frame makes a quarter of the minimum image size (as to its width or height). For example, for an image 600 x 800 pixels the
100% width of the frame is calculated as follows: 1/4 from the minimum size (600 px) is 150 pixels.

Texture Brightness (0-200%). This parameter allows changing the brightness of the original texture. The brightness of the
original texture equals 100%. To darken the frame, set the value of the parameter less than 100%; to brighten the frame, set
a value higher than 100%.
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Flip Texture Vertically

Button Disabled

 
Flip Texture Vertically

Button Enabled

 
Flip Texture Horizontally

Button Disabled

 
Flip Texture Horizontally

Button Enabled

Flip Texture Vertically . When the button is enabled, the texture is oriented to the horizontal line, that is top-down.

 

Flip Texture Horizontally . When the button is enabled, the texture is oriented to the vertical line, that is right-to-left.

 

There are several variants of texture lay-out in corners and on the sides of the frame.

Without rotation (the Tumble Texture button  is disabled).

Texture rotates in the corners and on the sides (the buttons Tumble Texture  and Tumble Texture in Corners 
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Check-box Scale Image to Frame

is disabled

 
Check-box Scale Image to Frame

is enabled 
and yellow is set as the background color

 are enabled).

Texture rotates on the sides but not in the corners (the Tumble Texture button  is enabled while the Tumble

Texture in Corners button  is disabled).

 

Scale Image to Frame. When the check-box is enabled, the image is scaled to fit the frame. When the check-box is
disabled, the frame overlays the image on it borders.

Frame Color. This parameter sets the color of the frame under the pattern (this parameter can be set only if the check-box
Scale Image to Frame is enabled. To select a color double-click on the color plate and select a color from the Select Color
dialog.
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Count = 2

 
Count = 10

Transparent. When the check-box is enabled, the pattern is drawn on a trasparent background. It can be useful on an
image with several layers to use the lower layer(s) as the background color for the pattern.

Check-box Transparent enabled

 

Random Patterns. When the check-box is enabled, the pattern frame is generated using randomly selected objects.

Frame Created Using Four Random Patterns

Count (2-20). The number of patterns taken from the Texture Library to create a frame.

Random Seed (0-9999). This is the starting number for the random number generator. Every number corresponds a particular
set and distribution of patterns.
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Random Patterns Frame
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STROKES FRAME

The Strokes Frame is made up of straight lines drawn along the border. The width of the frame as well as the width, the
number and the length of the lines can be set in the Settings Panel.

The Settings Panel offers the following parameters for this digital picture frame.

 

Frame Color. This parameter sets the color of the strokes that form the picture frame. Select a color by double-clicking the
color plate and choosing a color from the Select Color dialog.

Light-green color selected

 

Transparent. When the check-box Transparent is enabled, the image under the frame gets transparent. One may need it
on an image with several layers; in this way, the image on the lower layer(s) is visible and serves as a frame.
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Frame Width = 40%

 
Frame Width = 90%

 
Stroke Width = 2%

 
Stroke Width = 7%

Check-box Transparent enabled

 

Frame Width (0-100%). This parameter sets the width of the frame on which strokes are drawn. At 0% there is no frame, at
100% the width of the frame makes a quarter of the minimum image size (as to its width or height). For example, for an image
600 x 800 pixels the 100% width of the frame is calculated as follows: 1/4 from the minimum size (600 px) is 150 pixels.

 

Stroke Width (1-10%). This parameter sets the width of the strokes in percent from a quarter of the minimum image size (as
to its width or height). The higher the value of the parameter, the wider the strokes are; if the strokes are extremely wide,
they merge and look like one thick line.
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Stroke Count = 30

 
Stroke Count = 150

 
Stroke Length = 20%

 
Stroke Length = 50%

Stroke Count (1-300). This parameter sets the number of strokes drawn on each side of the image. The higher the value,
the more strokes are drawn on each side of the image.

 

Stroke Length (1-100%). This parameter sets the maximum length of the drawn strokes. The stroke length is calculated in
percent from the length of the side along which it is drawn. For example, if the side length is 800 px and the value of the
parameter Stroke Length is 50%, then the maximum length of the drawn strokes is 400 pixels.

 

Random Seed (0-9999). This is the starting number for the random number generator that defines the distribution of
strokes. Every number corresponds to a particular strokes distribution (provided all other parameters stay the same).
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FRAME SCRATCHES

The Scratches Frame represents a color frame with a "scratched" surface, through which the original image can be seen.
The width of the frame as well as the width, the number and the length of the scratches can be set in the Settings Panel.

The Settings Panel offers the following parameters for this picture frame.

Frame Color. This parameter sets the color of the scratched frame. Select a color by double-clicking the color plate and
choosing a color from the Select Color dialog.

Brown color selected

 

Transparent. When the check-box Transparent is enabled, the image under the frame becomes transparent. One may need
it on an image with several layers; in this way, the image on the lower layer(s) is visible and serves as a frame.
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Frame Width = 40%

 
Frame Width = 90%

 
Border Width = 0%

 
Border Width = 100%

Check-box Transparent enabled

 

Frame Width (0-100%). This parameter sets the width of the frame on which scratches are made. At 0% there is no frame,
at 100% the width of the frame makes a quarter of the minimum image size (as to its width or height). For example, for an
image 600 x 800 pixels the 100% width of the frame is calculated as follows: 1/4 from the minimum size (600 px) is 150 pixels.

 

Border Width (0-100%). This parameter sets the width of the outer border of the frame on which no scratches are made. It
is set in percent from the frame width. At 0% there is no outer frame at all and scratches are drawn right from the image
border. The higher the value of the parameter, the thicker the solid border is; at 100% the border occupies a half of the frame
width.

 

Stroke Width (1-10%). This parameter sets the width of the scratches in percent from a quarter of the minimum image size
(as to its width or height). The higher the value of the parameter, the wider the strokes are; if the strokes are extremely
wide, they merge and look like one thick line.
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Stroke Width = 2%

 
Stroke Width = 7%

 
Stroke Count = 20

 
Stroke Count = 70

 
Stroke Length = 10%

 
Stroke Length = 40%

 

Stroke Count (1-300). This parameter sets the number of lines "scratched" on each side of the frame. The higher the value,
the more scratches are made on each side of the frame.

 

Stroke Length (0-100%). This parameter sets the maximum length of the scratches. The maximum length is calculated in
percent from the length of the side along which it is drawn. For example, if the side length is 800 px and the value of the
parameter Stroke Length is 50%, then the maximum length of the scratches is 400 pixels.

 

Random Seed (0-9999). This is the starting number for the random number generator that defines the distribution of
scratches on the frame. Every number corresponds to a particular distribution of scratches (provided all other parameters
stay the same).
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PAGE CURL

The Page Curl effect creates a page curl on an image. The color of the curl, its form and the torsion level are adjusted in
the Settings Panel.

The Settings Panel offers the following parameters for this effect.

 

Background Color. The color plate Background Color allows setting the color of the area under the curl. Double-click on
the color plate Background Color to choose a color from the Standard Color Selection Dialog box.

Green Color is set

 

Transparent. When the check-box Transparent is enabled, the area under the curl becomes transparent. One may need it
on an image with several layers; in this way, for example, another photo can be visible under the page curl.

 
Check-box Transparent

is enabled

 

Curl Color. The color plate Curl Color allows setting the color of the curl’s underside. Double-click on the color plate Curl
Color to choose a color from the Standard Color Selection Dialog box.
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Torsion = 60%

 
Torsion = 90%

 
Obliquity = 10

 
Obliquity = 50

 
Yellow is set for the underside

of the page curl

 

Torsion (0-100%). This parameter sets the level of torsion of the curl. The higher the value, the more twisted the curl is.

 

Obliquity (0-100%). This parameter sets the form of the curl. At values from 1 to 49 the corner of the image curls to form a
cone (the vertex is on one end); at 50 the corner curls to form a cylinder; and at values from 51 to 100 it forms a cone
again, but the vertex is on the opposite end.

 
Obliquity = 90

 

Line with markers on both ends defines the corner to be curled, the position of the curl line and the curling direction. Use
the markers to set the position of the line. To move a marker, bring the cursor on it, press the left mouse button and drag the
marker to a new position. It is impossible to curl more than half of the image.
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Gradient = 20% Gradient = 50% Gradient = 100%

 

 

 

 

 

Gradient (0-100%). This parameter adds volume to the curl by adjusting the contrast of mid-tones.
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SQUARES FRAME

The Squares Frame represents a picture frame made of square tiles. The width, the quantity, the color of the tiles and the
opacity of their edges are defined in the Settings Panel.

The frame Squares consists of two parts: Outer Frame - on the image below it is made up of green tiles, and Inner Frame
- blue tiles.

The Settings Panel offers the following parameters for this digital picture frame.

Transparent. When the check-box Transparent is enabled, the image under the frame becomes transparent. One may need
it on an image with several layers; in this way, the image on the lower layer(s) is visible and serves as a frame.

Check-box Transparent enabled

Color Gradient (0-100%). This parameter changes the opacity of the tiles' edges. At 0% the tiles' edges are solid, as you
increase the value of the parameter the transparency of the edges increases, the tiles look more three-dimensional.
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Color Gradient = 5%

 
Color Gradient = 40%

 

Outer Frame

Squares Color. The color plate Squares Color in the Outer Frame field sets the color of the outer tiles. Select a
color by double-clicking the color plate and choosing a color from the Select Color dialog.

Green color selected

Random Colors. When the check-box Random Colors is enabled, the outer frame is formed by motley tiles.

Check-box Random Colors
for the Outer Frame is enabled

Outer Frame Width (0-100%). This parameter sets the width of the outer frame. At 0% the outer frame is not drawn
(only the inner frame appears), at 100% the width of the frame makes a quarter of the minimum image size (as to its
width or height).
Square Count (0-20). This parameter sets the number of squares that the outer frame will include at the defined
width. At 0 the outer frame will not be drawn at all.
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Outer Frame Width = 50%,
Square Count = 5

 

Outer Frame Width = 50%,
Square Count = 10

Inner Frame

Squares Color. The color plate Squares Color in the Inner Frame field sets the color of the inner tiles. Select a color
by double-clicking the color plate and choosing a color from the Select Color dialog.

Blue color is selected

Random Colors. When the check-box Random Colors is enabled, the inner frame is formed by motley tiles.

Check-box Random Colors
for the Inner Frame is enabled

Inner Frame Width (0-100%). This parameter sets the width of the inner frame. At 0% the inner frame is not drawn
(only the outer frame appears), at 100% the width of the frame is a quarter of the minimum image size (as to its width
or height).
Max Square Count (0-20). This parameter sets the maximum number of squares in the defined width of the inner
frame. At 0 the inner frame will not be drawn at all. At a value of the parameter > 0 the number of squares in every row
is set at random and vary from 0 to the set maximum number.
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Inner Frame Width = 50%,
Max Square Count = 5

 

Inner Frame Width = 50%,
Max Square Count = 10

Random Seed (0-9999). This is the starting number for the random number generator that defines the distribution of tiles at
the inner border of the frame. Every number corresponds to a particular tiles distribution (provided all other parameters stay
the same).
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RAGGED FRAME

The Ragged Frame is a frame consisting of medium-sized random particles that create an effect of ragged edges. The
width, the color and the level of effect are adjusted in the Settings Panel.

The Settings Panel offers the following parameters for this picture frame.

 

Frame Color. This parameter sets the color of the frame. Select a color by double-clicking the color plate and choosing a
color from the Select Color dialog.

Rose color is set

 

Transparent. When the check-box Transparent is enabled, the image under the frame becomes transparent. One may need
it on an image with several layers; in this way, the image on the lower layer(s) is visible and serves as a frame.
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Frame Width = 15%

 
Frame Width = 100%

Merge Level = 0 Merge Level = 1 Merge Level = 3

Check-box Transparent enabled

 

Frame Width (0-100%). This parameter sets the width of the frame. At 0% there is no frame, at 100% the width of the
frame is a quarter of the minimum image size (as to its width or height). For example, for an image 600 x 800 pixels the 100%
width of the frame is calculated as follows: 1/4 from the minimum size (600 px) is 150 pixels.

 

Merge Level (0-8). This parameter sets the level of particles merging at the inner edge of the frame. At Merge Level = 0
the frame consists of small random particles, as you increase the value, particles get larger and merge to form a ragged
frame.
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Merge Level = 4 Merge Level = 6 Merge Level˙ = 8

Edge Color = Purple Edge Color = White Edge Color = Light Purple

Glow Intensity = 0 Glow Intensity = 40 Glow Intensity = 90

 

Random Seed (0-9999). This is the starting number for the random number generator that defines the distribution of
particles at the inner border of the frame. Every number corresponds to a particular particles distribution (provided all other
parameters stay the same).

  

Edge Color. The parameter determines the color of glow at the inner edge of the frame. It is possible to create a shadow
effect by choosing a dark color. To change the color, click on the color plate and select a new one from the Select Color
dialog.

Glow Intensity (0-100). The parameter specifies the width and brightness of the glow effect.
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SPRAY FRAME

The Spray Frame creates a paint spray effect at the image borders. The width, the color and the spray density can be set
in the Settings Panel.

The Settings Panel offers the following parameters for this picture frame.

 

Frame Color. This parameter sets the color of the frame. Select a color by double-clicking the color plate and choosing a
color from the Select Color dialog.

Yellow color is set

 

Transparent. When the check-box Transparent is enabled, the image under the frame becomes transparent. One may need
it on an image with several layers; in this way, the image on the lower layer(s) is visible and serves as a frame.
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Frame Width = 30%

 
Frame Width = 100%

 
Density = 40

 
Density = 120

Check-box Transparent enabled

 

Frame Width (0-100%). This parameter sets the width of the frame. At 0% there is no frame, at 100% the width of the
frame makes a quarter of the minimum image size (as to its width or height). For example, for an image 600 x 800 pixels the
100% width of the frame is calculated as follows: 1/4 from the minimum size (600 px) is 150 pixels.

 

Density (0-200). This parameter sets the spraying density. The higher the value of the parameter, the denser the spraying
is. The spraying starts on the borders, therefore the density on the outer border is higher than on the inner one.
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Random Seed (0-9999). This is the starting number for the random number generator that defines the distribution of
particles at the inner border of the frame. Every number corresponds to a particular particles distribution (provided all other
parameters stay the same).
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ARTISTIC FRAME

The Artistic Frame with transparent borders can give any photo a festive and elegant look.

The Settings Panel offers the following parameters for this digital picture frame.

 

Frame Color. This parameter sets the color of the frame. Select a color by double-clicking the color plate and choosing a
color from the Select Color dialog.

Yellow color is set

 

Transparent. When the check-box Transparent is enabled, the image under the frame becomes transparent. One may need
it on an image with several layers; in this way, the image on the lower layer(s) is visible and serves as a frame.
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Frame Width = 20%

 
Frame Width = 80%

Smooth Grain Spot

Check-box Transparent enabled

 

Frame Width (0-100%). This parameter sets the width of the frame that will include the defined number of sub-frames. At
0% there is no frame, at 100% the width of the frame makes a quarter of the minimum image size (as to its width or height).
For example, for an image 600 x 800 pixels the 100% width of the frame is calculated as follows: 1/4 from the minimum size
(600 px) is 150 pixels.

The Artistic Frame has three Frame Types: Smooth, Grain and Spot.

 

Inverse Gradient. This parameter sets the direction of the color intensity fade - either inside (when the check-box Inverse
Gradient is enabled) or outside the image (when the check-box is disabled).
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SubFrame Count = 2

 
SubFrame Count = 8

Circle Radius = 0% Circle Radius = 20% Circle Radius = 80%

  
Check-box Inverse Gradient disabled

  
Check-box Inverse Gradient enabled

 

SubFrame Count (0-10). This parameter sets the number of sub-frames that will fit into the frame width.

 

Circle Radius (0-100%). This parameter sets the cutout corner radius. At 0% there is no cutout corner at all, at 100% the
cutout corner makes a quarter of the minimum image size (as to its width or height).
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Check-box "Symmetric" is enabled

 
Check-box "Symmetric" is disabled

FROST FRAME

The Frost frame imitates frost crystals that grow on windows when a pane of glass is exposed to below-freezing
temperatures. Apply this effect to add some winter freshness to your image.

The Settings Panel offers the following parameters for this frame:

 

Symmetric. When the check-box is enabled, the frost pattern is symmetric. You can disable the check-box to get a fancier
pattern, but it will increase the processing time.

 

Ice Color. This parameter sets the color for the frame. Click on the color plate and select a color from the Select Color
dialog.
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Width = 20%

 
Width = 75%

 
Freeze Level = 1

 
Freeze Level = 10

 
Ice Color: rosa

 

Width (10-100%). This parameter defines the area of the image that will be "frozen". At 100% the width of the frame is a
third of the minimum image size (as to its width or height).

Freeze Level (1-10). This parameter sets the freezing intensity. At 1 the frame is softly frozen, at 10 the freezing is more
intensive.

 

Melting (0-100). This parameter sets the ice state - the higher the parameter, the more melted the ice looks.
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Melting = 0%

 
Melting = 80%

 
Ice Density = 2

 
Ice Density = 15

 
Shadow = 0%

 
Shadow = 100%

 

Ice Density (1-50). This parameter sets the density of the frost. The higher the value of the parameter, the denser the ice
is. The "freezing" starts at the frame edge, therefore the frost on the outer border is denser than on the inner border.

Shadow (0-100%). This parameter sets the size of the shadow the frost casts. At 0 there are no shadows. As you increase
the value, the size of the shadows increases. High values of the parameter give volume to the frame.

 

Homogeneity (1-200). This parameter sets the amount of color shades used when generating frost. The higher the value of
the parameter, the fewer shades are used and the flatter the frost looks.
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Homogeneity = 50

 
Homogeneity = 200

 

Pattern (0-9999). Every value of this parameter corresponds to a unique combination of frost crystals. The defined value is
the starting number for the random number generator that creates a unique frost pattern on the frame.
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Width = 15%

 

Width = 50%

 

Blur = 5

 

Blur = 30

ARTISTIC CROP

The Artistic Crop effect accentuates a certain part of an image by blurring the rest of it. The focus of attention is shifted to
this part and the photograph is seen in a new light.

Working with the Artistic Crop involves two processes:

1. Frame creation.
2. Adjusting the image in the frame.

Frame. The frame is created from a part of the original image. Adjust the parameters for the frame:

Width (0-100%). This parameter sets the width of the frame. At 0% there is no frame at all, at 100% the frame takes
up most of the image.

Blur (0-60). Set the intensity of image blurring. The higher the value, the more blurred the frame is. At 0 the frame is
not blurred at all.

Overlay Color. Select the color that will overlay the frame. Click on the color plate and select a color from the Select
Color dialog.
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Opacity = 10%

 

Opacity = 90%

 

Width = 5

 

Width = 20

 

Green color selected

Opacity (0-100%). This parameter sets the opacity of the overlay color. Opacity = 100% corresponds to the maximum
filling of the frame with the overlay color. At 0% all colors are the same as on the original image.

Border Line. It is the separation line between the frame and the image. Adjust parameters for the Border Line:

Width (0-100). This parameter sets the width of the separation line in pixels. At 0 there is no border line.

Color. Click on the color plate to select a color for the Border Line in the Select Color dialog.

Adjusting the image in the frame. The image can be scaled and shifted relative to the frame.

The parameter Scale Image to Frame defines the way the image is scaled to the frame, if scaled at all.

No Scaling. The image is not scaled to the frame. In this way you can accentuate a certain part of the image.
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Option "No Scaling" enabled

Keep Image Ratio. The image is scaled keeping the proportion of the original image.

 

Option "Keep Image Ratio" enabled

Keep Border Ratio. The image is scaled in such a way that the summarized width of the horizontal sides is equal to
the summarized width of the vertical sides. In this case a small part of the image (either in height or in width) is cut
out.
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Option "Keep Border Ratio" enabled

Image Shift. This parameter sets the position of the image in the frame. The image can be shifted horizontally and vertically:

Horizontal. At values under 0, the image shifts to the left; at values over 0, the images shifts to the right.
Vertical. At values under 0, the image shifts downwards; at values over 0, the image shifts upwards.

 

Image Shift

The values of the parameter vary between -100% and 100%. By default the parameters are set to 0, that is the image is in
the center of the frame.

It is also possible to shift the image on the frame using the mouse cursor:

Press the Ctrl  on the keyboard and you will see a dotted frame. Put the cursor inside the dotted frame, press the left

button of the mouse and, keeping it pressed, drag the frame. The parameters of the Image Shift will be recalculated
accordingly and the image will be automatically processed.
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PASSE-PARTOUT

The Passe-Partout effect allows you to apply a mat or a cardboard for mounting and framing your digital pictures. It creates
margins around the image enhancing its visual appeal.

Using the passe-partout jointly with the Classic Frame has a truly powerful impact on a viewer. The frame options are
shown on a separate tab.

 
Size = 20

 
Size = 60

 

Adjust the parameters of the effect:

 

Size (1-100). The parameter changes the width of the passe-partout.

Bevel Depth (0-100). The parameter sets the thickness of the border cutting line (in % of the general passe-partout width).
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Bevel Depth = 10

 
Bevel Depth = 45

 
White Bevel

 
Beige Bevel

Color. You can select the mat and bevel colors in the color plates.

Blue Mat

Scale Image to Frame. When the check-box is enabled, the image is scaled to fit the frame. When the option is disabled,
the frame applies over the image.

Attention! A part of the image will be cropped to keep the aspect ratio.
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Scale Image to Frame check-box is disabled

 
Scale Image to Frame check-box is enabled

 
Outer Slope

 
Inner Slope

 
Shadow = 40

 
Shadow = 100

Slope. Define what the bevel looks like by choosing one of the options: Outside or Inside.

Shadow (1-100). Adjust the intensity of the shadow on the inner edge of the passe-partout.
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Chamfer = 10

 
Chamfer = 50

 
Straight Chamfer

 
Round

Light Source. Move the marker on the ball to set the probable light source that affects the appearance of the shadow.

Chamfer (0-100). The parameter changes the size of the sloping edge in the corners.

You can adjust the chamfer shape:

Round. The inner corner takes a rounded shape.

Ledge. The inner corner has a square shape.
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Ledge

 
Round + Ledge
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VIGNETTE

Vignette is a gradual darkening/lightening of an image towards its edges that highlights the subject of a photo by shading its
surroundings. The effect creates visual interest and adds vintage elegance to your images. The effect parameters are
adjusted in the Settings Panel.

 

Frame Parameters:

Frame Color. Using the color plate, adjust the color of the vignette. Click on the color plate to select a new color from the
standard dialog.

Oval Blue Vignette

Transparent. Enable the check-box to make the vignette transparent.
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Size = 20 Size = 90

Opacity = 50 Opacity = 100

Transparent Vignette

Size (1-100). The parameter changes the effect area.

Opacity (1-100). The parameter defines the transparency of the vignette. At 100%, the vignette is completely opaque.

Shape (-100...100). The parameter affects rounding of the edges and changes the central part of the image from a
rectangle (at negatives values) to a circle (at positive values).
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Shape = -80 Shape = 80

Smooth Transition = 0 Smooth Transition = 20

No Shift Shift to the Right

Smooth Transition (0-100). The parameter adjusts the smoothness of the border between the vignette and the central
part. Increasing the value increases the fading effect.

Position. Move the white marker to shift the vignette. You can see the current coordinates of the center in the X and Y
fields.
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HAND PAINTED FRAME

The Hand Painted Frame provides images with one or more areas of various shapes. A photo fragment can be placed in
these transparent areas to make a framed photo.

These frames were made by professional artists exclusively for use in AKVIS ArtSuite. 
Also, they can be used with AKVIS Frames (free software).

Attention! The Hand Painted Frame is only available in ArtSuite Standalone.

The default frame pack comes with the program. Also, you can download the free set of frames or purchase frame
packs with different themes (wedding frame pack, frames with a travel theme, etc.). Each frame pack is a zip file. Do
not open the file yourself. Copy it to a folder. It will only work in ArtSuite/Frames.

In addition, you can create and use your own frames.

Working with a Hand Painted Frame is a little different than with other frames and effects in the program. You can work
with multiple images. There are frame templates in which you can insert two or more images, without cropping or another
time-consuming editing.

 

Follow these steps to add a photo to a Hand Painted Frame:

Step 1. Open the source images: press  in the Control Panel and choose one or more photos.

The thumbnails of the uploaded images are displayed under the Image Window.
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The active image (which you are currently using) is outlined with a gray line. Choose another image by clicking on it.

To remove an image from the list, choose it and press  or the Delete -key.

Step 2. Select a frame pack. In the list, you can see the Default Pack (that goes with the program) and all additional
frame packs which you downloaded and installed.

List of Packs

When you select a pack, its first frame template becomes visible on the square button.

Click this button to see all frames in the pack. Select the desired photo frame by clicking on it.

Hint: You can also use your own frames. They can first be prepared and saved in any folder on your computer.
An image used as a frame must have one or more transparent areas of any shape and must be saved in PNG
format.

To load your own frame in AKVIS ArtSuite, select <Custom>… at the bottom of the list of the packs, and
choose a frame (a PNG image).

Step 3. The program will automatically choose the first image in the list of images to place in the frame.
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If the Hand Painted Frame has more than one area for photos and the default order of images (which is chosen
automatically) within the frame is not as desired, you can change it manually.

Choose an image in the list of images and drag it into the frame.

You can also place an image in an area by double-clicking it with the left mouse button.

Note: Transferring photos to a frame by double-clicking is more useful when a frame has only one area. If there is
more than one area, the program will choose a photo based on its aspect ratio in relation to the area. For
example, horizontal photos (which have greater width than height) would be placed in horizontal areas, etc.

Step 4. You can change the size, the position, and the rotation angle of every image relative to the frame.
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To reposition an image in the frame, bring the cursor into the selected area and left-click (the cursor's shape will
change to that of perpendicular bilateral arrows ), then while keeping the left mouse button pressed, drag the

cursor.

To resize an image in the frame, bring the cursor to the edge of the selection box (the cursor will change shape to that
of a bilateral arrow ), and after pressing and holding the left mouse button, drag the cursor to increase or decrease
the size of the image.

To rotate an image, bring the cursor near to a corner marker of the selection box (the cursor will change to the shape
of elliptical double arrows ), press the left mouse button and while keeping it held, move the cursor.

For transparent one-hole templates, the Clipping option is available. Click  next to the template sample, then run

the image processing  to make the frame more dense and opaque.

Step 5. When all adjustments to the images are done, press the  button to start processing.

Step 6. To save the final result press the  button and in the Save As dialog window enter a name for the file,

select the file type (TIFF, BMP, JPEG, or PNG) and choose a folder in which to save the file.

Attention! The original photo is converted to the frame format. Therefore, if the frame is RGB/8, the photos will
be converted to this format as well. Keep this in mind when creating your own frames.

Note: Additional themed frame packs (except the Free Pack) must be registered! Read the instructions.
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INSTALLING AND REGISTERING FRAME PACKS

The AKVIS frame packs can only be used with AKVIS ArtSuite standalone, not with the plugin version. The plugin cannot
use such frames, since the image size will be changed. 
To work with the frame packs, you can also download and use the AKVIS Frames program which is available free of charge!

A free set of frames (visible as Default Pack in Library) is included in AKVIS ArtSuite. Also you can download additional
themed frame packs (for example, a wedding frame pack, frames with travel themes, etc.).

To order a frame pack go to the frame pack page, where you will see all available frame packs. Each pack is fully
represented in thumbnails.

After an order has been paid, a link to the frame pack as a .zip will be sent along with a license number for registering the
pack.

 

How to install a frame pack in ArtSuite:

Step 1. Download the frame pack.
Step 2. Copy the .zip file (do not unzip it!) to a folder which has been selected in ArtSuite’s Preferences.

By default, this is AKVIS folder in Users Shared Documents.
Where you can find this folder:

in Windows 10/8.1/8/7: Users\Public\Documents\AKVIS
in Mac: Users/Shared/AKVIS

You can choose another folder in the Preferences!

Attention! Do not open the file yourself. Just copy it to a folder. It will only work in ArtSuite!

The .zip file is loaded by ArtSuite and displayed in the Library. If you unzip the file you won't find the images, only
thumbnails, because the hi-res frames are protected.

You may need to re-start ArtSuite to make the new pack visible in the Library.

Step 3. In the Settings Panel select: Frames - Hand Painted Frame.

Step 4. You will see all of the loaded frame packs in a list, and the frame thumbnail below.

AKVIS ArtSuite

115

https://akvis.com/en/frame-packs/index.php?utm_source=help
https://akvis.com/en/frames/index.php?utm_source=help
https://akvis.com/en/frame-packs/index.php?utm_source=help


Default Pack - these frames go with the program (included in the setup file). Besides these default frames included in
ArtSuite, an additional free set of 30 frames (Free Pack) is available for download. Both Default Pack and Free Pack
do not require registration to use.

Purchased frame packs must be registered with a license number (registration code). See the "unregistered" mark in the
above image. Only after this has been done is it possible to use the frames with the program.

 

How to register a frame pack in ArtSuite:

The frames will be available to use only after registration. Activate each pack with its serial number.

Step 1. Open the Frame Packs Manager.
Step 2. Choose the frame pack in the list and click on Activate.

Step 3. In the activation window enter your name and the serial number (registration key) you received after
purchasing the pack.

Choose an activation method — by direct connection to the activation server or by email. We recommend registering by
direct connection, since it is more convenient. To register using this method your computer must be connected to the
internet.
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Step 4. Click on the ACTIVATE button.

Registration is complete! The "unregistered" sign near the pack's name disappeared. Repeat for all packs. You can now
use the frames!

 

How to Delete a Frame Pack in AKVIS ArtSuite:

You can delete both packs by AKVIS and custom frame packs.

Step 1. Open the Frame Packs Manager.
Step 2. Choose the frame pack in the list and click on Delete.
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CREATING A CUSTOM FRAME PACK

In addition to the hand painted frames available in the ArtSuite Library and downloadable themed frame packs, you can
design your own picture frame collection.

Learn how to make custom frames for AKVIS ArtSuite using the AliveColors image editor. You can use any program that
supports selections and transparency.

 
Custom Frame

Creating Frames

Step 1. In the AliveColors graphics editor, open an image you want to transform into a frame (File -> Open).

 

Image in AliveColors

Step 2. Create a hole for a photo in the frame.

Choose one of the selection tools, for example, Rectangular Selection , create a selection on the image, and
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delete the selected area with the Delete  key or Edit -> Erase command.

Hole for a Photo

Note: To make multiple holes for several photos in the frame, create new selections in the Add mode  and

delete all of the fragments.

Remove the selection with the command Select -> Deselect or by pressing Ctrl+D .

Step 3. Draw a colored frame around the hole. To do this, add the Stroke layer effect (Layers -> Layer Effects) with
the following settings:

Stroke Layer Effect

To add a volume, apply the Outer Shadow layer effect and adjust its parameters:

AKVIS ArtSuite

120



Outer Shadow Layer Effect

Step 4. Complement the frame with a suitable inscription using the Text tool  and arrange it using the layer effects.

Ready-to-Use Frame

Save the frame into a specially created folder. Select the PNG format and make sure that transparency is enabled!

In the same way, design the other frames and save as PNG files in that folder.

 

AKVIS ArtSuite

121



 

Creating a Pack

Creating and using frame packs is only available in the standalone version of AKVIS ArtSuite or in the AKVIS Frames
freeware.

Step 5. Run AKVIS ArtSuite.

Choose Frames -> Hand Painted Frame and click on Frame Packs Manager. In the window that appears, click the
Custom Pack button.

In the first field of the dialog box, enter a name for the group of frames, for example, My Frames. Then click on
Browse... and choose your new frames folder. Click OK.

Creating a Frame Pack

Now you have your own frame collection that is always available for use in the ArtSuite program!

 

Decorating Photos

Step 6. In the list of the packs, select My Frames. One of your new frames will be displayed in the square preview
window at the bottom of the Settings Panel. Click to open a list with all the frames in the set. Select the desired frame
with a mouse click.

In the Control Panel, click on  and select photos to process. The thumbnails of the images are displayed under the

main window. The first image will be automatically placed into the frame. Double-click on the thumbnail to choose
another photo.
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Adding Photos

Step 7. Adjust the position of the photo in the frame for the best result. Then start the image processing with .

Framed Photo

You can save the result using  and print with .

 

AKVIS ArtSuite

123



Original Image Sample for a Frame Result

MAKING YOUR OWN FRAMES

The author of this tutorial is Irina Vesnina.

With AKVIS ArtSuite you can create your own frames, choosing a classic frame or pattern.

Classic Frame

Step 1. Prepare the image you want to use as a frame. A picture of any size, in the JPEG, BMP, TIFF or PNG format can be
used as a texture. For example, this:

  
Texture Samples

Step 2. AKVIS ArtSuite (standalone). Open an image, from which you want to make a frame, by double clicking in the blank
area or pressing  in the Control Panel.

Step 3. Select the Classic Frame type in the Settings Panel.

 
Original Image in AKVIS ArtSuite

The Library contains a rich collection of textures and patterns grouped in sets.
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To load your own texture into ArtSuite, select <Custom>… in the list.

This will open the dialog to load your own texture.

Step 4. Use the settings to resize, mirror the texture, adjust brightness, or flip the frame vertically to change the frame's
appearance.

Here is the result:

Frame Variants

Pattern Frame

Step 1. Prepare the image which you will use for the frame. For best results, use a square image in the PNG format with a
transparent background. If you have no such images, you can choose any other, such as:

  
Texture Samples

Step 2. Start AKVIS ArtSuite (standalone). Open the image which you want to use in the frame by double clicking in the
blank area or pressing  in the Control Panel.

Step 3. Choose the Pattern frame type from the Settings Panel.
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Original Image in AKVIS ArtSuite

To load your own texture into ArtSuite, select <Custom>… in the list of the Library.

This will open the dialog to load your own texture.

Step 4. Adjust the settings to rotate the texture, add a frame color, or adjust brightness to change the appearance of the
frame.

Here is the result:

Frame Variants
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CREATE YOUR OWN ART GALLERY

Art plays an important role in the expression of inner thoughts and beauty in our life. There are so many genius painters in
world history. They have presented true masterpieces to the world. But it is impossible to visit all museums and exhibitions.

Using AKVIS ArtSuite you can choose your favourite pictures, artists and create your own art gallery.

Art gallery

The author of this tutorial is Gordon Sisson. He used AliveColors, but you can work with any other photo editor
compatible with AKVIS plugins or the standalone version of AKVIS ArtSuitе.

So let's start with Leonardo da Vinci and his famouse painting "Mona Lisa".

Step 1. Open an image in AliveColors.
Step 2. Call the plugin from the main menu of the photo editor Effects -> AKVIS -> ArtSuite.
Step 3. Let's choose the frame style from the drop-down menu Frame at the Setting Panel. The first will be the
Classic style.
Step 4. Select a group in the Library, click on the texture, and choose the appropriate pattern.
Step 5. Adjust the parameters of the frame.

The result will be shown in the After tab.

Step 6. Press the  button to apply the result and close the plugin window.
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Here is the same picture, but we have changed the texture.

Let's take Edgar Degas "Dancers in Blue". This painting is calling us to dance with these ballet-dancers.

Here are the variantes of the frames:
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The next painting is Rene Magritte "The Blank Signature" that brings us to the world of absurdity and muddle.

Let's try to frame his painting in different frames and then choose the most suitable one.

 

Here is Paul Cezanne’s "Ginger Jar and Fruit". This painting is worth framing too.
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And the last but not at least is Georgia O’Keeffe’s "Bella Donna".

Here is another choice of a classic frame from the texture library:

Let's try to use another style of the frame with "Bella Donna":

Step 1. Let's increase the canvas size. Call from the main menu of AliveColors Image -> Canvas Size, set the values
of the parameters and save them.
Step 2. Call the plugin AKVIS ArtSuite from the main menu of the photo editor.
Step 3. We choose Strokes frame for this painting but you can choose any other frame from the drop-down menu
Frame and set the values of the parameters as shown below.
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Step 4. Apply the result and close the plugin window.

Here is the result:

You can try other frames.

There are enough styles, colors and frame types to experiment. Have fun!
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CHANGE SEASONS

This tutorial was based on the methods used by Andrew Blazhin, who was a winner in our New Year 2009 photo-editing
competion, for his photo in the Category "4 Seasons".

   
Seasons

Click on any of the images to see a larger version in another window

 

All work was done in AliveColors using the AKVIS ArtSuite and AKVIS Decorator plugins.

Step 1. Open the image in the photo editor.

Step 2. Here is a picture of summer. We will use it to represent the other seasons too. Let's start with autumn. A
characteristic of autumn is yellowed vegetation, so let's begin the change there. To begin call the AKVIS ArtSuite
plug-in (in the menu select Effects -> AKVIS -> ArtSuite).

On the Settings Panel we will choose the effect Channel Mixer and adjust its settings.

Click on  to make the changes.

Here is the result:
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Step 3. The image looks gloomy. We will brighten it up with one of the standard features of AliveColors. In the main
menu select Image -> Adjustment -> Brightness/Contrast and increase the amount of Brightness.

Click on OK to apply the change.

Here is autumn:

Step 4. After fall, of course, is winter. But what is missing here? Snow. We will give the mountains a frosty appearance
by applying an ice texture with the AKVIS Decorator plug-in.

First use the Quick Selection  to select the mountains.
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Call the AKVIS Decorator plug-in (Effects -> AKVIS -> Decorator). In the texture Library we will find a suitable
texture and adjust it to our liking. For example:

Start the process of applying the texture by pressing the  button. The result will be shown in the After tab.

To accept the result and return to the photo editor, press the  button.

The mountains are encased in frost.

Step 5. Let’s continue. Now select the ground and the house.
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Once again we will call the AKVIS Decorator plug-in. This time we choose a different texture and adjust the
parameters.

Start the texture application process. Apply the result and return to the photo editor.

Step 6. We will try to cover the grass with snow. We select the desired area with the Quick Selection  as before.

Then in the editor’s main menu we click Image -> Adjustment -> Curves and in the window that appears, we choose
High Key preset.

Click on OK to apply the effect.
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Step 7. Let’s return to the mountains. We will brighten them, as well as the home and fence, thereby reducing contrast
and making a great realistic portrait. To do this we used the Lighten tool  in AliveColors.

A few simple steps and we have winter:
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Original Image Result

BERLIN CATHEDRAL: RETRO POSTCARD

The author of this tutorial is Valentina Aynagos.

 

Berlin is one of the most exciting Europe metropolises. I'm never bored of walking on the streets of this city, where modern
and high-tech architectural buildings are neighbors with impressive XIX century cathedrals and palaces representing the glory
of the imperial Prussia.

I took this photo of the Berlin Cathedral on a gloomy November day. I found the composition good enough to make a postcard
out of it to share with my friends back at home. This cathedral was built in 1894, so I wondered how it could look on
postcards at the end of the XIX century. So I also created a "retro" version of my postcard.

I used AliveColors and the plugin versions of AKVIS Sketch and AKVIS ArtSuite.

Step 1. Open the photo in your photo editor.

Photo of the Berlin Cathedral

Step 2. My digital camera is rather simple and the photos do not always come out well. So I adjusted it with the
command Image -> Adjustment -> Curves. If you have a good photo you do not need to do this step.
Step 3. Then I called the AKVIS Sketch plugin: Effects -> AKVIS -> Sketch.
Step 4. I adjusted the parameters as follows:
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Photo-to-Sketch Settings

and clicked on the button  to process the whole image, then clicked on the button  to apply the result and

close the plugin.

Pencil Sketch from the Photo

Step 5. I increased the size of the canvas on 0,6 cm with the command Image -> Canvas Size to add a simple frame
to the image, so that it looks like a postcard.

AKVIS ArtSuite

138



Canvas Size dialog box

Here is the result:

Put the Sketch Image into a Frame

Step 6. I wanted to create a retro version of my postcard, say, Berlin in 1908, for example. For this purpose I used
AKVIS ArtSuite: Effects -> AKVIS -> ArtSuite.

I selected Effects in the drop-down menu and the effect Black and White. Then I moved the point on the circle to
the right to add a red cast to the photo to imitate the sepia technique. I also slightly moved the red control on Color
to Gray Mixer to lighten the tones.

Hint: Use the Autorun-mode in the program Preferences  (this mode is active by default) to observe the

changes at once. It will save you time when picking out the tone. Otherwise you will have to press  each

time.
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Sepia Effect

Step 7. Press the button  to apply the result and close the plugin.

I also added an inscription "Berlin 1908". Well, the photo was taken some 100 years later, but I hope, the Berliners will
forgive me this little liberty.

Old Postcard
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AKVIS PROGRAMS

 

AKVIS AirBrush — Airbrushing Techniques on Your Photos

AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a special airbrush tool
that sprays paints or inks. The software works as an artistic filter creating stylish colorful airbrush designs from images using
chosen settings of photo-to-painting conversion. More…

 

AKVIS Artifact Remover AI — JPEG-Compressed Image Restoration

AKVIS Artifact Remover AI uses artificial intelligence algorithms to remove JPEG compression artifacts and restore the
original quality of compressed images. The software is available free of charge. It is a must for both home users and
professionals. More…

 

AKVIS ArtSuite — Frames and Effects for Your Photos

AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains many templates and
texture samples that can be used to create a virtually limitless variety of options for generating frames.
Decorate a photo to give it an original and festive look! More…
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AKVIS ArtWork — Collection of Painting & Drawing Techniques

AKVIS ArtWork is photo to painting software designed to imitate different painting techniques - Oil Painting, Watercolor,
Gouache, Comics, Pen & Ink, Linocut, Pastel, and Pointillism. ArtWork helps you to create a piece of art out of any picture!
More…

 

AKVIS Chameleon — Photo Collage Creation

AKVIS Chameleon is a fun to use tool for photo collage creation. It makes the process easy and entertaining. The tool is
very easy to handle as it does not require precise selection of objects.
Using the software you can quickly create your own photo collages. More…

AKVIS ArtSuite

142

https://akvis.com/en/artsuite/index.php?utm_source=help
https://akvis.com/en/artwork/index.php?utm_source=help
https://akvis.com/en/artwork/index.php?utm_source=help
https://akvis.com/en/artwork/index.php?utm_source=help
https://akvis.com/en/chameleon/index.php?utm_source=help
https://akvis.com/en/chameleon/index.php?utm_source=help


 

AKVIS Charcoal — Charcoal & Chalk Drawings

AKVIS Charcoal is a creative tool for conversion of photos into charcoal and chalk drawings. Using the program you can
make professional-looking expressive black and white images. Playing with colors and options you can achieve outstanding
artistic effects, such as sanguine and others. More…

 

AKVIS Coloriage — Add Color to Black and White Photos

AKVIS Coloriage allows colorizing B&W photos and replacing colors in color images, performing selective colorization and
desaturation. It helps to breathe new life into your old family photographs, bring a vintage or artistic appearance to your
digital images. More…

 

AKVIS Decorator — Resurface and Recolor

AKVIS Decorator lets you change the surface of an object in a realistic manner. The program puts on a texture keeping the
volume of an object, following its folds and creases. The new pattern looks absolutely natural and makes you see things
differently. Recoloring is also made easy. More…
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AKVIS Draw — Hand-made Pencil Drawing Effect

AKVIS Draw converts your photos into hand made pencil drawings. The software creates realistic looking line art illustrations,
produces both B&W and color drawings. Add a hand-drawn look to your pictures! More…

 

AKVIS Enhancer — Bring Detail To Your Pictures

AKVIS Enhancer is image enhancement software that detects detail in underexposed, overexposed and mid tone areas of a
photo with uneven exposure. Enhancer improves every part of the image! The software works in three modes: Improve
Detail, Prepress, and Tone Correction. The program offers a fast method to fix a dark photo, add contrast and brightness to
a picture, it lets you improve color and adjust tones. More…

 

AKVIS Explosion — Fabulous Particle Explosion Effects

AKVIS Explosion offers creative destruction and particle explosion effects for your photos. It bursts an object and applies
dust and sand particles to an image. With the software, you can create eye-catching graphics in just a few minutes! More…
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AKVIS Frames — Decorate Your Photos with Frames

AKVIS Frames is a free program designed for working with the AKVIS frame packs

 

AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality!

AKVIS HDRFactory lets you create a High Dynamic Range image from a series of shots or from one single photo. The
program can also be used for photo correction. The program brings life and color to your photos! More…

 

AKVIS LightShop — Light and Star Effects

AKVIS LightShop lets you create an infinite number of astounding light effects! The program offers advanced lighting
techniques for adding stars and glow effects to images. A light effect draws attention and brighten up any photo. Add a little
magic to your pictures! More…
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AKVIS Magnifier AI — Change Image Size without Quality Loss

AKVIS Magnifier AI helps to resize images without loss in quality. Featuring neural networks based algorithms, Magnifier AI
enlarges digital pictures to super-high resolution and produces stunning wall-sized prints. More…

 

AKVIS MakeUp — Retouch Your Portrait Photos!

AKVIS MakeUp improves your portraits giving them a professional look. The software retouches facial imperfections making
your skin radiant, beautiful, pure and even. The program adds glamour to your pictures and creates a high key effect. Look
your best in every photo with AKVIS MakeUp! More…

 

AKVIS NatureArt — Bring Nature to Your Photos

AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your photos. The program
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includes a number of effects: Rain

 

AKVIS Neon — Glowing Drawings from Photos

AKVIS Neon lets you create amazing glowing lines effects. The software transforms a photo into a neon image that looks like
drawn with luminescent ink. More…

 

AKVIS Noise Buster — Digital Noise Reduction

AKVIS Noise Buster is software for noise suppression on digital and scanned images. Digital noise can be seen as artifacts
and random red and blue pixels that compromise the smoothness of a photo. The program is efficient against both color and
luminance noise. More…
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AKVIS OilPaint — Oil Painting Effect

AKVIS OilPaint turns your photos into oil paintings. The mysterious production of a painting happens right before your eyes.
The unique algorithm authentically reproduces the technique of the real brush. With this cutting-edge software you can
become a painter! More…

 

AKVIS Pastel — Turn Photos into Pastel Paintings

AKVIS Pastel turns your photos into pastel paintings. The program converts your photo into a lifelike digital art imitating one
of the most popular artistic techniques. AKVIS Pastel is a powerful tool to unleash your creativity! More…

 

AKVIS Points — Apply Pointillism Effect to Your Photos

AKVIS Points lets you transform your photos into paintings using one of the most exciting artistic techniques - pointillism.
With the software you can easily create gorgeous works of art in a pointillist manner. Discover the world of bright colors!
More…
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AKVIS Refocus AI — Focus Improvement & Blur Effects

AKVIS Refocus AI improves the sharpness of out-of-focus and blurry photos, enhances the entire image or partially, creating
a selectively focused area. It's also possible to add bokeh and lens blur effects to your photos. The program provides five
image processing modes: Refocus AI, Tilt-Shift, Iris Blur, Motion Blur, and Radial Blur. More…

 

AKVIS Retoucher — Image Restoration Software

AKVIS Retoucher is an efficient program for photo restoration and photo retouching. The software removes dust, scratches,
stains, and other defects that appear on damaged photos. It intelligently reconstructs the missing parts of the photo using
the information of the surrounding areas. More…

 

AKVIS Sketch — Turn Your Photos into Pencil Sketches
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AKVIS Sketch converts photos into amazing pencil drawings. The software creates realistic color artworks and B&W
sketches, imitating the technique of graphite and color pencil. The program offers these photo to drawing conversion styles:
Classic, Artistic, and Maestro, - each with a series of presets. AKVIS Sketch allows you to feel like a real artist! More…

 

AKVIS SmartMask — Save Time on Complex Selections!

AKVIS SmartMask is an efficient selection tool that saves time and is fun to use. Selection has never been so simple! The
software considerably increases your productivity. You will be freed from boring work and will have more room for creativity
and realization of your ideas. More…

 

AKVIS Watercolor — Aquarelle Art from Photos

AKVIS Watercolor easily makes a photo look like a brilliant and vibrant watercolor painting. The software turns ordinary
images into amazingly realistic aquarelle pieces of art. More…
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